• Duplication of any or all of the contents of this software and instruction manual or lending of this software to third parties without the express permission of the copyright holder is strictly prohibited by copyright law.
• Sony cannot be held liable in any way for monetary losses, lost profits or claims from third parties arising from the use of this software.
• Should any manufacturing defects occur, Sony's responsibility shall be limited solely to replacing said defective merchandise.
• This software is approved for use only with the specified equipment.
• Sony reserves the right to change software specifications without prior notice.

Program © 1999 Sony Corporation
Documentation © 1999 Sony Corporation
© 1999 Sony Corporation All right reserved.

• MD Editor 2, PictureGear and VAIO are the registered trademarks of Sony Corporation.
• Microsoft, MS-DOS and Windows are the registered trademarks of Microsoft Corporation.
• IBM and PC/AT are the registered trademarks of International Business Machines Corporation.
• Macintosh is the registrated trademark of Apple Computer Inc.
• Adobe® and Adobe® Acrobat® Reader are the trademarks of Adobe Systems Incorporated.
• Other companies and product names are the trademarks or the registered trademarks of each company.
# Table of contents

## Preparation
- Installing the software ......................... 4
  - Installing the MD Editor 2 ............... 4
  - Installing the Label Maker ............. 5
  - Setting up the On-line Manual .......... 5
  - Installing the Adobe Acrobat Reader ................................... 6
- Uninstalling the software ....................... 6

## Starting up the software ..................... 7
- Starting up the software for the first time ........................................ 8
- Starting up the software for the second and subsequent times ......................... 8

## Names and functions of screen .......... 9
- Main Bar ....................................... 9
- Tool Bar ..................................... 10
- MD Bar ........................................ 11
- MD Window .................................... 12
- CD Bar ....................................... 15
- CD Window ................................... 16
- PC CD Bar ................................... 19
- PC CD Window ............................... 20
- CD to MD Window ............................ 22
- PC CD to MD Window ....................... 22

## Quitting the software ........................ 23

## Operating an MD
- Listening to an MD ................................ 24
  - Listening to an MD using the MD Bar ....... 24
  - Listening to an MD using the MD Window ... 24
- Assigning names to MDs ......................... 25
  - Assigning a disc (or track) name ......................... 25
  - To use the text data input by other application ................. 26

## Recording from a CD to an MD ....... 27
- Recording from a CD to an MD ....................... 27

## Editing recorded MDs ...................... 31
- Moving recorded tracks (MOVE function) ........................................ 31
- Dividing recorded tracks (DIVIDE function) ................................. 33
- Combining recorded tracks (COMBINE function) .......................... 34
- Erasing a part of a track (A-B ERASE function) ......................... 35
- Erasing recordings (ERASE function) ......................................... 37

## Operating a CD
- Listening to a CD ................................ 39
  - Listening to a CD using the CD or PC CD Bar ......................... 39
  - Listening to a CD using the CD or PC CD Window ......................... 39
- Assigning names to CDs ...................... 40

## Creating labels
- About the Label Maker .......................... 42
- Starting up the Label Maker .................... 42
- Creating labels with Label Maker .......... 43

## Additional Information
- Troubleshooting .................................. 48

## Index ........................................... 50
Installing the software

Use this procedure to install this software onto your computer’s hard disc. Set the computer to the operation mode before proceeding.

Installing the MD Editor 2

1. Insert the supplied CD-ROM into the computer. The “MD Editor2 & PictureGear Label Maker Set Up” dialog box appears.
   If the dialog box does not appear, double-click “Install” in the CD-ROM folder.

2. Click “Set up MD Editor 2.”

3. Follow the instructions that appear in the display to install the application.

4. Click “Finish.” Control returns to the “MD Editor2 & PictureGear Label Maker Set Up” dialog box.

Note
A folder is created as a result of the installation. This folder is used by the software. Do not erase, move, or change its contents.
Installing the Label Maker

When installing version 4.0 of PictureGear Label Maker, if an older version already exists in your computer, the older version will be overwritten by version 4.0.

1. Click “Set up PictureGear Label Maker” in the “MD Editor2 & PictureGear Label Maker Set Up” dialog box.

2. Follow the instructions that appear in the display to install the application.

Note
If you restarted your computer by selecting “Yes, I want to restart my computer now” in the dialog box that appeared at the end of the Label Maker installation, you should double-click “Install” in the CD-ROM folder to set up the on-line manual or install the Adobe Acrobat Reader.

Setting up the On-line Manual

English version of on-line manual is automatically installed when you install MD Editor 2.
To install another language version, do the procedure below to overwrite the English version with the language version that you select.

1. Select the language in the “MD Editor2 & PictureGear Label Maker Set Up” dialog box.

2. Click “Set up the on-line manual.”

3. Follow the instructions that appear in the display to set up the on-line manual.
Installing the Adobe Acrobat Reader

You must install the Adobe Acrobat Reader in your computer in order to open the on-line manual.

1. Click “Set up Adobe Acrobat Reader 4.0 [English].”

2. Follow the instructions that appear in the display to install the application.

After you have completed installation, click “EXIT” and remove the CD-ROM.

Uninstalling the software

If you do not need the MD Editor 2, Label Maker, or Adobe Acrobat Reader, uninstall the software as follows:

1. Click “Start,” point to “Settings,” and then click “Control Panel.”

2. Double-click “Add/Remove Programs.”
The “Add/Remove Programs Properties” dialog box appears.

3. Select and click “MD Editor 2,” “PictureGear Label Maker 4.0,” or “Adobe Acrobat Reader 4.0” from the program list below.

4. Click “Add/Remove.”
The “Confirm File Deletion” dialog box appears.

5. Click “Yes.”
Uninstaller starts up and the software selected in step 3 is deleted automatically.

Note

If you uninstalled the Label Maker from the computer in which the PictureGear software is already installed, it become impossible to print labels through the PictureGear as well. If this happens, uninstall the PictureGear, and then reinstall it.
Starting up the software

If the softwares listed below are already installed in your computer, do not start them up while the MD Editor 2 is active.

Softwares for controlling the MD deck

• MD Editor Supplied with the PCLK-MD1 personal computer connecting kit, or the MD deck MDS-PC1 which includes a personal computer connecting kit.
• MD Editor (VAIO) Supplied with Sony VAIO personal computers.
• Media Bar Supplied with Sony VAIO personal computers.
• Media Communicator Supplied in the PCLK-PX1 and other kits for connecting an MD deck to a personal computer.

Starting up the MD Editor 2 with any of these programs active will result in a malfunction.

If you are using several CD-ROM drives, you may need to select the drive to be used for playing music CDs before starting up MD Editor 2.

Selecting the CD-ROM drive

1 On the desk top, double-click “My Computer,” double-click “Control Panel,” and then double-click “Multimedia” to display the “Multimedia Properties” window.
2 Click the “CD Music” tab and select the CD-ROM drive to be used for music CD playback.
Starting up the software for the first time

➤ Click “Start,” point to “Programs,” point to “MD Editor 2,” and then click “MD Editor 2.”
This software is then started and the MD Editor 2 Main Bar appears.
When you start the software, the following display appears:

If a dialog appears instead of the Main Bar, select a serial port.
On the serial port selection dialog box, select one of options COM1, COM2, COM3, and COM4 that is available for your computer. Also check that the MD deck is connected to the serial port you selected.

Notes
• Set up the serial port that is to be used for this kit so that it is unavailable to the other software.
• To verify that the serial ports of your computer are enabled, call the vendor of your computer.

Starting up the software for the second and subsequent times

➤ Click “Start,” point to “Programs,” point to “MD Editor 2,” and then click “MD Editor 2.”
The software is started and the MD Editor 2 Main Bar appears.

Notes
• Be sure to quit MD Editor 2 before turning off the MD deck.
• Do not use a bi-directional remote while MD Editor 2 is active.
• If an MD Editor 2-compatible component other than a CD player is connected to the MD deck through the monaural (2P) mini-plug cord, do not use any of the controls other than the volume control while the MD deck is active. Using these controls may result in a malfunction.
Names and functions of screen

Main Bar

This bar is referred to as the MD Bar (page 11) if the function that is selected on “2 Function name display” is MD, as the CD Bar (page 15) if CD is selected, and as the PC CD Bar (page 19) if CD-ROM drive of a computer is selected.

1 **SONY logo**
   Drag with the left mouse button to move the Main Bar up and down.
   Right-click to pop up a menu.

2 **Function name display**
   Click to display and select a function. You can select one from CD, MD, and PCCD.

3 **Tool Bar switch**
   Click to show and hide the Tool Bar (page 10).

4 **Help button**
   Click to open Help.

5 **Exit button**
   Click to exit MD Editor 2.
**Tool Bar**

To show the Tool Bar, click the Tool Bar switch (page 9) on the Main Bar.
When you click an icon on the Tool Bar, the active function is switched and the corresponding window appears on the screen. Note that you can open only one Tool Bar window at a time.

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CD icon</td>
<td>Click to display the CD Window (page 16).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>MD icon</td>
<td>Click to display the MD Window (page 12).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>PC CD icon</td>
<td>Click to display the PC CD Window (page 20).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>CD to MD icon</td>
<td>Click to display the CD to MD Window (page 22).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>PC CD to MD icon</td>
<td>Click to display the PC CD to MD Window (page 22).</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**MD Bar**

To show the MD Bar, select MD in the Function name display (page 9) on the Main Bar. Use this bar to operate an MD in the MD deck (page 24).

1. **Disc number/Disc name display**
   Shows the disc name of the MD currently inserted in the MD deck.

2. **Track number/Track name display**
   Click to select a track you are going to play.

3. **Time display**
   Shows the playback time of the current track.

4. **MD operation button**
   - ![Play button](image)
     : Play button
   - ![Pause button](image)
     : Pause button
   - ![Stop button](image)
     : Stop button
   - ![AMS (PREV, NEXT) button](image)
     : AMS* (PREV, NEXT) button

* AMS = Automatic Music Sensor
  This function searches for the beginning of tracks.
MD Window

To show the MD Window, click the MD icon on the Tool Bar (page 10). Use this window to operate an MD in the MD deck (page 24).

Note
Except for the power switch, the buttons on the MD deck and the remote cannot be operated while the MD Window is open. If you attempt to use any of these buttons at this time, “REMOTE” will appear in the display. Furthermore, if you open the MD Window while the MD deck is already playing, playback will stop.

1 Reload button
Click to show the information about the MD currently inserted in the MD deck on the “3 Track name display” and “4 Disc information display.”
2 MD operation panel
- EJECT button
- AMS* (PREV, NEXT) button
- Reverse/Fast forward button
- Play button
- Pause button
- Stop button
- Record button
- MOVE button
  Click to display the “MOVE” dialog box (page 31).
- DIVIDE button
  Click to display the “DIVIDE” dialog box (page 33).
- COMBINE button
  Click to display the “COMBINE” dialog box (page 34).
- A-B ERASE button
  Click to display the “A-B ERASE” dialog box (page 35).
- ERASE (trash) button
  Click to display the “ERASE” dialog box (page 37).
- Printer button
  Click to start the Label Maker.

* AMS = Automatic Music Sensor
  This function searches for the beginning of tracks.

3 Track Name display
Click a track number to select the track.
Left-click a track name to rename the track.
Right-click a track name to save the currently displayed text
information as a CSV (Comma Separated Value) formatted file.
This file can be opened by spreadsheet software for use as a
personal database.

(continued)
4 Disc information display

- **MD disc icon**
  Click to select all the track names.

- **Disc Name display**
  Click to rename the disc.

- **Time display**
  Click to select a time display mode.

<table>
<thead>
<tr>
<th>Display mode</th>
<th>What is displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remain Time</td>
<td>Total time to be able to record the tracks on the MD.</td>
</tr>
<tr>
<td>Total Time</td>
<td>The total playing time of all tracks on the MD.</td>
</tr>
<tr>
<td>Elapsed Time</td>
<td>The elapsed playing time of the current track.</td>
</tr>
<tr>
<td>Track Remain</td>
<td>The remaining playing time of the current track.</td>
</tr>
</tbody>
</table>

- **Disc capacity display**

  ![Disc capacity display](image)

  - : Size of recorded space
  - : Size of space scheduled to be recorded
  - : Size of free space

5 Quit button
Click to close the MD Window.
CD Bar

To show the CD Bar, select CD in the Function name display (page 9) on the Main Bar. Use this bar to operate a CD in the CD player connected to the MD deck (page 39).

1 Disc number/Disc name display
   Shows the disc name of the CD currently inserted in the CD player.

2 Track number/Track name display
   Click to select a track you are going to play.

3 Time display
   Shows the playback time of the current track.

4 CD operation buttons
   - : Play button
   - : Pause button
   - : Stop button
   - AMS* (PREV, NEXT) button

   * AMS = Automatic Music Sensor
       This function searches for the beginning of tracks.

5 MD Window button
   Click to open the MD Window.
To show the CD Window, click the CD icon on the Tool Bar (page 10). Use this window to operate a CD player connected to the MD deck (page 39).

1 Display switching button (when connecting a CD changer only)
Click to alternate the display on the “5 Disc information display” between the “5-disc display mode” and “1-disc display mode.”

2 Reload button
Click to show the information about the CD currently inserted in the CD player on the “4 Track name display” and “5 Disc information display.”
3 **CD operation panel**

- AMS* (PREV, NEXT) button
  Operable during play.
- Reverse/Fast forward button
- Play button
- Pause button
- Stop button

*AMS = Automatic Music Sensor
This function searches for the beginning of tracks.

4 **Track name display**

Click a track number to select the track.
Left-click a track name to rename the track.
Right-click a track name to save the currently displayed text information as a CSV (Comma Separated Value) formatted file.
This file can be opened by spreadsheet software for use as a personal database.

5 **Disc information display**

Indicates either 5-disc or 1-disc display mode.
If a CD changer is connected to the MD deck, a 5-disc display mode appears in the display.

- **5-disc display mode**

- **1-disc display mode**

<table>
<thead>
<tr>
<th>Disc No</th>
<th>Disc Name</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>Best Selection</td>
<td>47:21</td>
</tr>
<tr>
<td>002</td>
<td>Rock Selection</td>
<td>38:14</td>
</tr>
<tr>
<td>003</td>
<td>Jazz Selection</td>
<td>58:38</td>
</tr>
<tr>
<td>004</td>
<td>Pop Selection</td>
<td>7:48</td>
</tr>
<tr>
<td>005</td>
<td>Fusion Selection</td>
<td>12:29</td>
</tr>
</tbody>
</table>

- **CD disc icon**
  Click to select all the track names.

- **Disc Name display**
  Click to rename the disc.
Time display
Click in the 1-disc display mode to select a time display mode.

<table>
<thead>
<tr>
<th>Display mode</th>
<th>What is displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Time</td>
<td>The total playing time of all tracks on the CD.</td>
</tr>
<tr>
<td>Elapsed Time</td>
<td>The elapsed playing time of the current track.</td>
</tr>
<tr>
<td>Track Remain</td>
<td>The remaining playing time of the current track.</td>
</tr>
</tbody>
</table>

Only Total Time is shown in the 5-disc display mode.

Quit button
Click to close the CD Window.
PC CD Bar

To show the PC CD Bar, select PCCD in the Function name display (page 9) on the Main Bar. Use this bar to operate a CD in the CD-ROM drive of your computer (page 39).

1 Disc number/Disc name display
   Shows the disc name of the CD currently inserted in the CD-ROM drive of your computer.

2 Track number/Track name display
   Click to select a track you are going to play.

3 Time display
   Shows the playback time of the current track.

4 CD operation buttons
   ![Play button] : Play button
   ![Pause button] : Pause button
   ![Stop button] : Stop button
   ![AMS* (PREV, NEXT) button] : AMS* (PREV, NEXT) button

* AMS = Automatic Music Sensor
  This function searches for the beginning of tracks.

5 MD Window button
   Click to open the MD Window.
To show the PC CD Window, click the PC CD icon on the Tool Bar (page 10). Use this window to operate a CD in the CD-ROM drive of your computer (page 39).

1 **Reload button**
Click to show the information about the CD currently inserted in the CD-ROM drive on the "3 Track name display" and "4 Disc information display".

2 **CD operation panel**
- **EJECT button**: Inoperable depending on the type of CD-ROM drive.
- **AMS* (PREV, NEXT) button**: Operable during play.
- **Reverse/Fast forward button**
- **Play button**
- **Pause button**
- **Stop button**

* AMS = Automatic Music Sensor
This function searches for the beginning of tracks.
3 Track name display
Click a track number to select the track.
Left-click a track name to rename the track.
Right-click a track name to save the currently displayed text information as a CSV (Comma Separated Value) formatted file. This file can be opened by spreadsheet software for use as a personal database.

4 Disc information display

<table>
<thead>
<tr>
<th>Display mode</th>
<th>What is displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Time</td>
<td>The total playing time of all tracks on the CD.</td>
</tr>
<tr>
<td>Elapsed Time</td>
<td>The elapsed playing time of the current track.</td>
</tr>
<tr>
<td>Track Remain</td>
<td>The remaining playing time of the current track.</td>
</tr>
</tbody>
</table>

4 CD disc icon
Click to select all the track names.

5 Disc Name display
Click to rename the disc.

6 Time display
Click to select a time display mode.

5 Quit button
Click to close the PC CD Window.
CD to MD Window

To show the CD to MD Window, click the CD to MD icon on the Tool Bar. Use this window to record from a CD in the CD player to an MD in the MD deck.

PC CD to MD Window

To show the PC CD to MD Window, click the PC CD to MD icon on the Tool Bar. Use this window to record from a CD in the CD-ROM drive to an MD in the MD deck.
Quit the software

Click the red 
[x] on the Main Bar (page 9).
The message “How do you quit MD Editor2?” appears in the display.
Click “Power OFF” if you want to turn the MD deck’s power off as quitting, “Exit” if you want to leave the MD deck’s power on, or “Cancel” if you want to cancel quitting.
Operating an MD

Listening to an MD

Listening to an MD using the MD Bar

1. Show the MD Bar.

2. Click Track number/Track name display on the MD Bar. A list of tracks in the MD appears.

3. Click the track you want to play from the track list box. Playback starts at the track you clicked.

Listening to an MD using the MD Window

1. Open the MD Window. A list of tracks in the MD appears.

2. Click the track number of the track you want to play from the Track Name display. Double-clicking the track number starts the playback of the track.

3. Click in the MD Window (valid only when you clicked a track number in step 2). Playback starts at the track you clicked in step 2.
Assigning names to MDs

Notes
• You can only input alphanumeric characters and the following symbols:
  !"#$%&'()*+,-./;:<=>?@`^`
  If an MD encoded with the letters other than those above is played back, the correct letters will not be displayed.
• If the disc’s write protect tab is set to protect, character input, recording, editing etc., will not be possible. Slide the record-protect tab so that recording is possible.

Assigning a disc (or track) name

1. Open the MD Window.

2. Click Disc Name display (or Track Name display) on the MD (or track) to which you want to assign a name.
   You are ready to enter disc (or track) names.

3. Input the desired name.
   You can cut and paste an existing string using the menu which appears when you right-click in the edit mode.

4. Press the Enter key.
   The disc (or track) name you entered is saved and you are ready to enter another track name.
To use the text data input by other application

If you input track name beforehand using other text editing software, you can assign all names with one copy and paste operation.

1. Input the track name by using other text editing softwares. Delimit each name by pressing the Enter key on the computer’s keyboard.
   (ex.)
   
   track 3 name <Enter>
   track 4 name <Enter>
   track 5 name <Enter>
   :
   track 8 name <Enter>

2. Select all text and copy it into the clipboard. The actions you must take in this step varies according to the text editing software you use. For the procedure to copy text, refer to the instruction manual for the text editing software.

3. Click the Track Name display on the track to which you want to assign a name.
   You are ready to enter track names.
   Click the third track name if you entered track names as shown in (ex.).

4. Select “Paste” from the displayed edit menu by right-clicking. The track names are pasted in the same way as they are entered with the text editing software.
   In the example given above, from the third track name to the eighth track name are entered in the same way as they are entered with the text editing software.

Note
More than 255 letters cannot be input in a track.
Recording from a CD to an MD

Notes

• If the disc’s write protect tab is set to protect, character input, recording, editing, etc., will not be possible. Slide the record-protect tab so that recording is possible.
• Before recording, click all the MD icons to be recorded. The TOC information necessary for recording will be read.
• You cannot click any icon on the Tool Bar while the MD Editor 2 is recording on an MD. To stop recording, click the Stop button.

Recording from a CD to an MD

1. Adjust the recording level on the MD deck.
   For details, see the operating instructions supplied with the MD deck.
   When recording from a CD in the CD-ROM drive, you must first make the proper settings for the playback devices and playback volume. For details see “Settings for recording from a CD in the CD-ROM drive” on page 29.

2. Open the CD to MD or PC CD to MD Window (page 22).
   The tracks on the MD and CD appear in each window.

   During connection of a Sony CD changer with CONTROL A1 or CONTROL A1) jacks
   Click the CD you want to play in the Disc Name display.
3 Drag the track number of a track you want to record from the Track Name display in the CD or PC CD Window and drop it into the Track Name display or Disc Name display in the MD Window. When dragging and dropping a track to the Track Name display or Disc Name display in the MD Window for the first time, a dialog box showing the selected input selector appears. Check that the correct one is selected. The dropped track is shown in red in the Track Name display or Disc Name display in the MD Window as a candidate for recording. Repeat step 3 if you have another track you want to record. You can also select two or more tracks at a time by clicking the desired track numbers while holding down the Ctrl key. To select all tracks in the CD as candidates, drag and drop the CD disc icon (pages 17, 21) into the Track name display or Disc Name display in the MD Window.

Note
The dragging operation is canceled and displays the message “Insufficient free recording space” if it finds that the track you have just dropped do not fit on a single MD.

4 Click or in the MD Window. Recording starts.

Notes
• Do not activate any music CD software while MD Editor 2 is active. If such an application is already started when you start up MD Editor 2, quit that application.
• If you record a CD which contains many tracks on the nearly full MD, the message “Insufficient free recording space” appears in the display and the dragging operation is canceled.
• If the CD or MD information is not displayed properly after recording, click the Reload button. The information is updated.
• If the track number or name which has been recorded is displayed in red, restart the MD Editor 2. Otherwise, the MD Editor 2 may not function properly.
• If several CD-ROM drives are connected, do not change the CD in any of the drives while recording using MD Editor 2. If you do, the recording may be canceled.
When recording from a CD to an MD using the PC CD to MD Window, you should set the playback devices*1 and the playback volume in the “Volume Control” window*2.

Click “Volume Control” in the folder shown below to display the “Volume Control” window.

For Windows 98
Start menu — Programs — Accessories — Entertainment — Volume Control

For Windows 95
Start menu — Programs — Accessories — Multimedia — Volume Control

Setting for playback devices
This procedure is unnecessary if the MD deck is connected to the PHONES jack on the CD-ROM drive.

1 Display the “Volume Control” window, click “Options”, and then click “Properties.”
   The “Properties” window appears.
2 Click “Playback” and check all the playback devices in “Show the following volume controls.”
3 Click “OK.”
   The “Volume Control” window appears again.
4 Check “Volume Control” and “Mute”*3 for all the devices except “CD Audio.”
   The computer is now set up to output only the “CD Audio” sound.

*1 If you change the mixer device in the “Properties” window, the “Volume Control” window may appear with a different name such as “Playback Volume.”
*2 The playback devices that appear here refer to computer components that process audio and music. All the devices in your computer can be seen in “Show the following volume controls” in step 2.
*3 If you change the mixer device in the “Properties” window, “Mute” may be appeared as “Choice.” In this case, check “CD Audio” and uncheck the other devices.

(continued)
Setting the playback volume

When connecting the MD deck to the LINE OUT jack or the PHONES jack on your computer
1 Display the “Volume Control” window, move the “Volume” control to the highest position.
2 Adjust the CD volume.
   • When the MD deck is connected to the LINE OUT jack.
     Move the “Volume” control for “CD Audio” to the highest position.
   • When the MD deck is connected to the PHONES jack.
     Move the “Volume” control for “CD Audio” to the center position.
3 Move the “Balance” control for “Volume Control” and “CD Audio” to the center position.

When the MD deck is connected to the PHONES jack on the CD-ROM drive
Adjust the volume to the maximum level.

Notes
• After recording to an MD through the PC CD to MD window, make sure to reset the playback devices in the “Volume Control” window. If you use the settings for the procedure above, no sound will be output except for “CD Audio.”
• The above settings may automatically be modified depending on the software that you use. If such software is installed in your computer, do not activate them while MD Editor 2 is active.
• A low output level or distortion may occur depending on the computer that you use. If this happens, adjust the output level with the “Volume” control for “CD Audio” or “Volume Control.”
• When the MD is connected to the PHONES jack on the CD-ROM drive, a high output level may cause distortion. If this happens, adjust the output level with the “Volume” control for the PHONES jack.
Operating an MD

Editing recorded MDs

Note
You cannot undo any edit functions you performed on an MD.

Moving recorded tracks (MOVE function)

You can rearrange the order of tracks on an MD.

1. Open the MD Window (page 12).

2. Click the track number of the track you want to move from the Track Name display in the MD Window. The track name’s color you clicked changes.

Note
You can move only one track in a single move operation. The move function is disabled if you select more than one track.

3. Click on the MD operation panel. The “MOVE” dialog box appears.

To cancel the MOVE function, click .

4. Select the track number of the location you are moving the track to.

5. Click . The selected track is moved to the designated location.

To move a track by dragging

1. Open the MD Window (page 12).

2. Drag the track number of the track you want to move from the Track Name display in the MD Window.

3. Drop it to the desired location.
To move a track during playback

1. Open the MD Window (page 12).
2. Playback the track you want to move (page 24).
3. Click on the MD operation panel.
   The “MOVE” dialog box appears.
   To cancel the MOVE function, click .

   Note
   Check the track you are going to move in the “MOVE” dialog box.

4. Select the track number of the location you are moving the track to.
5. Click .
   The track in playback moves to the designated location.

   Note
   To deselect a track, click at a blank background in the MD Window.
   For example, click below the ERASE (trash) button on the MD operation panel.
Dividing recorded tracks (DIVIDE function)

1. Open the MD Window (page 12).

2. Playback the track you want to divide (page 24).

3. During playback, click on the MD operation panel at the position where you want to divide the track. The position is temporarily set. The “DIVIDE” dialog box appears, and rehearsal playback starts from the position you clicked.

4. Adjust the position to divide. Click in the “DIVIDE” dialog box. You can shift the dividing position in 1 step (= approximately 0.06 second) increments and can also drag to the left or right for adjustment. Rehearsal playback starts from the shifted position.

5. Click when the rehearsal playback proves satisfactory. The track is divided.
Combining recorded tracks (COMBINE function)

1. Open the MD Window (page 12).

2. Select two tracks you want to combine from MD Window. Click the track number of the first track, then, while holding down the Ctrl key, click the track number of the latter track.

   **Note**
   You can select a track and the subsequent track by proceeding to step 3 immediately after selecting one track.

3. Click \( \text{COMBINE} \) on the MD operation panel. The “COMBINE” dialog box appears. At the same time, the last 2-second part of the first track and the first 2-second part of the latter track are put together, and starts a rehearsal playback of approximately 4 seconds.

   To cancel the COMBINE function, click \( \text{Cancel} \).

   If the indicated track order is found incorrect, transpose the tracks by clicking \( \text{Rev} \) or restart the steps starting at step 2 after clicking \( \text{Cancel} \).

4. If the displayed tracks are correct, click \( \text{OK} \). The selected tracks are joined. The name of the first track becomes the name of the new track.
Combining the track in playback and the immediately following track

1. Open the MD Window (page 12).
2. Playback the first track (page 24).
3. Click on the MD operation panel. The “COMBINE” dialog box appears.
   At the same time, the last 2-second part of the first track and the first 2-second part of the latter track are put together, and starts a rehearsal playback of approximately 4 seconds.
   To cancel the COMBINE function, click .
   If the indicated track order is found incorrect, transpose the tracks by clicking or restart the steps starting at step 2 after clicking .
4. If the displayed tracks are correct, click .
   The selected tracks are joined. The name of the first track becomes the name of the new track.

Notes
• To deselect a track, click at a blank background in the MD Window. For example, click below the ERASE (trash) button on the MD operation panel.
• You cannot combine the track in playback with any track other than the one that immediately follows the current track.

Erasing a part of a track (A-B ERASE function)

1. Open the MD Window (page 12).
2. Playback the track of which you want to erase a part (page 24).
3 During playback, click on the MD operation panel when the playback of the part you want to erase starts (point A). The starting point (point A) is temporarily set. The “A-B ERASE” dialog box appears and starts the rehearsal playback of approximately 2 seconds up to point A.

4 Adjust the position of point A. Click in the “A-B ERASE” dialog box. You can adjust the position in 1 step (= approximately 0.06 second) increments and can also drag to the left or right for adjustment.

5 After the adjustment, click . Playback then starts at point A.

6 Continue playback, or click or to go to the point where you want the erase to stop (point B), and click . The ending point (point B) is temporarily set. Then the 2-second part up to point A and the 2-second part from point B are put together, and a rehearsal playback of approximately 4 seconds starts.

7 Adjust the position of point B. Click in the “A-B ERASE” dialog box. You can adjust the position in 1 step (= approximately 0.06 second) increments and can also drag to the left or right for adjustment.

8 After the adjustment, click . The specified A-B part is erased.
Erasing recordings (ERASE function)

Note
Erased tracks cannot be recalled.

1. Open the MD Window (page 12).

2. Click the track number of the track you want to erase from the Track Name display in the MD Window.
   When selecting more than one track, click the numbers while holding down the Ctrl key.
   To erase all tracks, click the MD disc icon (page 14).
   To erase the current track, skip to step 3, selecting no track.

3. Click the ERASE operation panel.
   The “ERASE” dialog box appears.

   ![ERASE dialog box]
   Erase selected track?
   OK Cancel

   To cancel the ERASE function, click Cancel.

4. If it is ok to erase the track(s), click OK.
   The selected track(s) is erased. The current track is erased if no track is selected.

To erase by dragging to

1. Open the MD Window (page 12).

2. Click the track number of the track you want to erase from the Track Name display in the MD Window.
   When selecting more than one track, click the numbers while holding down the Ctrl key.

3. Drag the selected track(s) into the ERASE operation panel.
   The tracks you selected are all erased.

(continued)
Erasing all tracks
You can erase all tracks that are recorded on an MD and all the tracks that are registered with that MD in a single operation.

1. Open the MD Window (page 12).
2. Click the MD disc icon.
3. Drag the MD disc icon (page 14) into on the MD operation panel.

Note
To deselect a track, click at a blank background in the MD Window. For example, click below the ERASE (trash) button on the MD operation panel.
MD Editor 2 allows you to control a CD player using operations almost identical to those for the CD-ROM drive.

Listening to a CD using the CD or PC CD Bar

1. Show the CD or PC CD Bar.
   
   During connection of a Sony CD changer with CONTROL A1 II (or CONTROL A1) jacks
   Click the Disk number/Disc name display to show a list of the available CDs. Then click the CD that you want to play.

2. Click Track number/Track name display on the CD Bar.
   A list of tracks appears.

3. Click the track you want to play from the track list box.
   Playback starts at the track you clicked.

Listening to a CD using the CD or PC CD Window

1. Open the CD or PC CD Window.
   
   During connection of a Sony CD changer with CONTROL A1 II (or CONTROL A1) jacks
   Click the CD that you want to play in the Disc Name display.
   
   A list of the tracks on the CD appears in the Track Name display.

2. Click the track number of the track you want to play from the Track Name display.
   Double-clicking the track number starts the playback of the track.

3. Click in the CD or PC CD Window (valid only when you clicked a track number in step 2).
   Playback starts at the track you clicked in step 2.
Assigning names to CDs

Names assigned to a CD are stored on the computer’s hard disc. Those names appear in the display on MD Editor 2 when the CD is inserted. Do the procedure below to assign names to a CD in the CD-ROM drive or CD player.

1. Open the CD or PC CD Window.

2. Click Disc Name display (or Track Name display) on the CD (or track) to which you want to assign a name.

   **During connection of a Sony CD changer with CONTROL A1Ⅱ (or CONTROL A1) jacks**
   Click the CD you want to name in the Disc Name display.

   You are brought into the edit mode in which you can enter disc (or track) names.

3. Input the desired name.
   You can cut and paste an existing string using the menu which appears when you right-click in the edit mode.

4. Press the Enter key.
   The disc (or track) name you entered is saved and you are ready to enter another track name.
**Notes**

- Assigned names on a CD are stored in the folder on the computer’s hard disc. Names appear in the display unless you click the Reload button.

- Assigned names on a CD are stored in the folder on the computer’s hard disc. Do not erase, move, or change the contents of this folder.

- You can view the names you entered here are only from the MD Editor 2; they are not reflected in the CD player. The names you entered from the CD player (Disc memo) are shown only on the CD player’s display and not reflected in the MD Editor 2.

- If you assign a name to a CD to which a CD text is assigned, you cannot see the CD text information in the MD Editor 2. To show the CD text information, click the Reload button in the CD or PC CD Window. The disc and track names assigned to the CD disappear when you click the Reload button.

- CD text information appears in the display only when the connected CD player supports CD text. CD text is not displayed when the CD is inserted in the CD-ROM drive, even the drive supports CD text.

- When you replace a CD in the CD-ROM drive with a new one, the name of the previous CD will continue to be displayed. Click the Reload button to display the name of the newly inserted disc.
Creating labels

About the Label Maker

This chapter explains how to create MD labels using the supplied PictureGear Label Maker software.
To create and print labels, you must first install the PictureGear Label Maker (page 5).

Note
Do not attach labels near the disc shutter, or at any other place not specifically designated for label attachment. Be sure to position the label inside the recessed area reserved for labels. The shape of the recessed area will vary from disc to disc.

Starting up the Label Maker

There are two ways to activate the Label Maker.
• Click on the MD Window.
• Double-click “PicLabel” placed on the folder shown below.
  X drive — Program files — Sony — PictureGear 3.2 — Goodies
  X drive is a name of the hard disc.
Creating labels with Label Maker

You can create labels with graphics or text for MDs and other media.

1. Display the MD Window.

2. Click to activate the Label Maker.
   A template of an MD label appears in the main display. The disc and track names that are currently displayed in the MD Window appear on the MD label. If you want to print the label with this information go to step 9.

   **To adjust the display size**
   Select the zoom magnification from the drop-down list in the main window.

   **To select another template**
   Click “Open Template” in the “File” menu. The “Open Template” dialog box appears.
   Select the file and click “Open” to display the template in the main window.

   The templates below can be selected:
   3.5-inch floppy disk, 3.5-inch MO disk, Hi8/8mm video cassette, CD-R, DV, Memory stick, MD, Mini DV, VHS video cassette, Audio cassette

3. Click “Add Image” in the “File” menu.
   The “Add Image” dialog box appears.

4. Select the file containing the image that you want, and then click “Open.”
   The main window appears again with image in the image palette on the right.

(continued)
The file formats displayed by Label Maker are as follows.

<table>
<thead>
<tr>
<th>File format</th>
<th>File extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bitmap</td>
<td>.BMP</td>
</tr>
<tr>
<td>JPEG</td>
<td>.JPG</td>
</tr>
<tr>
<td>TIFF</td>
<td>.TIF</td>
</tr>
<tr>
<td>FlashPix</td>
<td>.FPX</td>
</tr>
<tr>
<td>GIF</td>
<td>.GIF</td>
</tr>
<tr>
<td>Mavica</td>
<td>.JPG</td>
</tr>
<tr>
<td>Slipclip</td>
<td>.BMP (16-bit color)</td>
</tr>
</tbody>
</table>

5 Place the image.

Drag the desired image from the image palette onto the label creation area.

To place images automatically
Select the images and click “Autocopy” in the “Edit” menu. The image is pasted into the template area without changing the aspect ratio.

To make images round or square
Select the image in the label creation area and click “Round” or “Square” in the “Edit” menu. You can change the size of an image in the label creation area but not the size of an image in the template area.
To rotate the image 90 degrees
Select the image in the label creation area and click “Rotate” in the “Edit” menu.

To change the size of the image
Select the image and drag the frame.
To change the size without changing the aspect ratio, drag the image while holding down the Shift key.

To switch the positions of overlapping images or text
Select the image or text in the label creation area, and then click “Front” or “Back” in the “Overlap” menu to bring the selected item to the front or move it to the back.

To realign multiple images
Select images while pressing down the Shift key, or drag the images you want to realign and click “Align,” “Display Evenly,” “Condense,” or “Expand.”

If you selected “Align,” select the type of alignment by clicking “Align to Left,” “Align to Right,” “Align to Top,” or “Align to Bottom,” “Align to Center [Vertical],” or “Align to Center [Horizontal].”

If you selected “Display Evenly,” “Condense,” or “Expand,” select the orientation by clicking “Vertical” or “Horizontal.”

To add color to an image
Click “Add Color” in the “File” menu to open the “Color” dialog box.
Select the desired color and the color is displayed in the image palette.
The color, like other images, can be assigned to a template.

To delete an image
Select the image you want to delete in the image palette and click “Delete” in the “Edit” menu.
6 Enter the label text.
Click “Text” in the Edit menu or A and click at the desired position on the label creation area to open the “Text” dialog box. Click “Properties” to set the text attributes.

To change the font
Click “Change Font” to display the “Font” dialog box. Select the font name, style and size as needed. Then click “OK.”

To change the color of the text
Click “Text Color” or “Background” button according to the item whose color you want to change. The “Color” dialog box appears. You can specify a transparent background color by checking “Transparent.”

To change vertical/horizontal text direction
Check “Horizontal” or “Vertical.”

To rotate the text
Select the angle from the “Rotation” group box.

To change the text alignment position
Click “Left,” “Center,” or “Right” in the “Align” group box.

To change the text spacing
Enter the desired line spacing and character spacing in points.
7 Click “OK.”
The “Text” dialog box closes.

To delete the text
Select the text you want to delete in the label creation area and click “Delete” in the “Edit” menu.

To rotate the text 90 degrees
Select the text in the label creation area and click “Rotate” in the “Edit” menu.

To move overlapping texts to the front or back
Select the text in the label creation area and click “Front” or “Back” in the “Overlap” menu.

8 Save the label.
Click “Save As” in the “File” menu to open the “Save As” dialog box.
Select the folder, input file name, and then click “Save” to save the file.
The “Save As” dialog box closes.

9 Print the labels.
Click “Page Setup” in the “File” menu to select the page settings.
Click “Print” in the “File” menu, and then click “OK.”

10 Quit the Label Maker.
Click “Exit” in the “File” menu or click the close button in the top right corner of the window.
If you experience any of the following difficulties while using this software, use this troubleshooting guide to remedy the problem. Should any problem persist, consult your nearest Sony dealer. Please also refer to your computer’s manual, as well as the “Readme.txt” file installed on the hard disc with the software.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause/countermeasure</th>
</tr>
</thead>
<tbody>
<tr>
<td>The message “Communication port cannot be opened.” appears.</td>
<td>Another application may be using the serial port. → Quit the other application.</td>
</tr>
<tr>
<td>The message “Port not registered in System was used.” appears.</td>
<td>You selected a port that is not available on your computer during serial port setup. → Select a valid port while referring to the instruction manual for your computer.</td>
</tr>
<tr>
<td>The message “Cord Connection Error” appears.</td>
<td>The connector from the computer adapter is not connected properly to the serial port of the computer, or connected to a port that is not selected during serial port setup. → Check the connector for normal connection. The monaural (2P) mini-plug cord from the computer connector is not connected properly to the MD deck, or MD deck power cord is not connected to a power outlet. → Check the monaural (2P) mini-plug cord for normal connection. → Make sure that the power cord from the MD deck is connected to a power outlet.</td>
</tr>
<tr>
<td>No screen response or screen error.</td>
<td>→ Turn the power of the MD deck off and on, and then restart the MD Editor 2. → Start up another application often used and check if computer functions properly. → After uninstalling (page 6), try re-installing (page 4).</td>
</tr>
<tr>
<td>Character input, recording, editing etc., cannot be done.</td>
<td>The disc’s protect tab may be set for write protect. → Slide the tab so that recording is possible. The MD may probably be a commercial playback-only MD (an MD with prerecorded tracks). → Character input, recording, editing, etc., are not possible on commercial playback MDs.</td>
</tr>
<tr>
<td>Problem</td>
<td>Cause/countermeasure</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| The MD deck does not respond as a whole.                               | → Check the cables are connected properly.  
   → Check that “Serial Setup” has been done properly (page 8).  
   → Disconnect cables of the connector and then reconnect them.          |
| Displayed name of MD or CD does not match the disc’s data.             | → Click the Reload button (pages 12, 16, 20).  
   → Restart the MD Editor 2.                                             |
| Recording from a CD in the CD-ROM drive to an MD in the MD deck cannot be done. | → Check that the audio connecting cord is correctly connected.  
   → Check that the settings for the devices in the “Volume Control” window are correct (page 29). |
| Sound from the MD in the MD deck connected to the LINE IN jacks of a computer is not output from the computer’s speakers. | → Check that the audio connecting cord is correctly connected. Verify that the settings for the devices in the “Volume Control” window are correct. |
Index

A, B
A-B ERASE dialog box ..... 36
AMS ......................... 11
Assigning names to CDs .. 40
Assigning names to MDs .. 25

C
CD Bar ........................ 15
CD to MD Window .......... 22
CD Window .................. 16
COMBINE dialog box ..... 34
Combining recorded tracks (COMBINE function) ..... 34
Creating labels ............... 42

D
DIVIDE dialog box .......... 33
Dividing recorded tracks (DIVIDE function) ..... 33

E, F, G, H
Editing recorded MDs ..... 31
ERASE dialog box .......... 37
Erasing a part of a track (A-B ERASE function) ..... 35
Erasing recordings (ERASE function) .................... 37

I, J, K, L
Installing software .......... 4

M, N, O
Main Bar ...................... 9
MD Bar ........................ 11
MD Window .................. 12
MOVE dialog box .......... 31
Moving recorded tracks (MOVE function) .......... 31

P
PC CD Bar .................... 19
PC CD to MD Window ..... 22
PC CD Window .............. 20
Playback device .......... 29
Playback volume .......... 30
Playing a CD ............... 39
Playing an MD .............. 24

Q
Quitting ....................... 23

R
Recording from a CD to an MD ......................... 27

S
Screen
CD Bar ....................... 15
CD to MD Window .... 22
CD Window .................. 16
Main Bar ...................... 9
MD Bar ........................ 11
MD Window .................. 12
PC CD Bar .................... 19
PC CD to MD Window ........... 22
PC CD Window .......... 20
Tool Bar .................... 10
Serial port setup .......... 8
Settings for recording .... 29
Software
Installing .................... 4
Quitting ....................... 23
Starting up .................. 7
Uninstalling ............... 6
Starting up software .... 7

T
Tool Bar ...................... 10

U, V, W, X, Y, Z
Uninstalling software .......... 6

Sony online
http://www.world.sony.com/